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I. Introduction 





        Congratulations on your acquisition of Middle School Language Arts from Pro One Software!  We have worked hard to bring a program to you that helps you build up your language arts skills, but which is also fun and easy to use.  We think the Middle School Language Arts program fits this bill, and we hope you will agree. 





        In looking at the textbooks, workbooks, and software programs already on the market, we noticed that they generally did not integrate the language arts skills--vocabulary, spelling, reading, and writing.  One could purchase a vocabulary program, or a reading program, or a spelling program, or workbooks or textbooks to cover these areas.  However, we wondered why it would not be possible to integrate these areas so that the lessons could reinforce each other.  From this concept, Middle School Language Arts was born.





        Each grade level of Middle School Language Arts contains 28 lessons.  Each of these lessons include a spelling and vocabulary list and a reading selection.  Spelling and vocabulary activities are included for the word lists, and the reading selection makes use of the vocabulary taught in the lesson.  Also in each grade are four writing lessons, with each grade focusing on a different aspect of writing.  Taken as a whole, these lessons provide a good and substantial reinforcement of language arts concepts.








II. Using Middle School Language Arts 





II.1. System Configuration 





        Middle School Language Arts requires Windows 3.0 or higher, running in Standard or 386 Enhanced mode.  Any computer which can run in at least Standard mode can run Middle School Language Arts, although faster computers will certainly have improved performance.  Middle School Language Arts also works well with Windows 95.





	In order to hear the word pronunciation, you will also need a 16-bit sound card and speakers. 





        Middle School Language Arts is optimized for screen resolutions from 640 by 480 to 800 by 600.  Higher screen resolutions will work, but may make the program screens difficult to read. 








II.2. Program Installation 





	Directions for program installation are printed directly on the face of the CD.





II.3. Setting a Current User 





        The first time you run one of the Middle School Language Arts programs, you will be asked to enter a current user name.  One of the most helpful functions of Middle School Language Arts is its ability to display graphically your progress via a sophisticated graphing package.  In order to keep track of the data needed to generate the charts, you can enter up to 50 users.  At least one user must be entered for the program to run. 





        The first name you enter when you run Middle School Language Arts automatically becomes the current user.  After that, you can enter other users if you wish, and choose a current user from among them.





        When you exit the User window, the program will create user data files for everyone you entered, as well as a general user file which keeps track of the other files. User information cannot be kept on the CD-ROM, since it is read-only, so it must be kept on your hard drive.  The user information is kept in the directory C:\MSLAx (where "x" is the grade level) unless you specify another directory. 





        You can change and edit current users from many different screens in Middle School Language Arts. 








II.4. The Main Menu Screen 





        On the Main Menu Screen, you will notice that there are listed five main categories or activities that you may select: Reading, Spelling, Vocabulary, Writing and Practice.  To use any of the activities, push the corresponding number or use the mouse to click on the button. 





	To the lower left of the activity buttons on the screen is the lesson number.  You can use the up and down arrows to change lessons.  Some information about the topic of the current lesson is displayed as you change lessons.  (These lesson numbers apply to everything but the writing lessons.  When you click on Writing, you are given an opportunity to pick a writing lesson.)





        Along the bottom of the screen is a section showing the current user, and offering the buttons User, Graphs, About, Setup, and Exit.           








III. The Language Arts Activities





III.1. Reading Selections





	When you choose the reading activity, the reading selection for that lesson will load.  The underlined words are words that are used in the spelling/vocabulary list.





            If your screen is set to either 640 by 480 or 800 by 600, the layout of the lesson should be appropriate for your screen.  However, if you are using a different resolution, or if the lesson does not seem to be displayed correctly, you can change either the font used or the ruler.





	To change the font, you must mark part or all of the selection, then choose Font from the pull-down menu under the File heading (File/Font).  When you choose a new font, the part of the selection that you marked will be changed to the new font.  In order to change the ruler, you must first make the ruler visible by choosing Ruler from the pull-down menu under the File heading (File/Ruler), or push Ctrl-R.  You can edit the ruler with your mouse by dragging the end-of-line symbol in the ruler to make the ruler longer or shorter.  





           You can also move or resize pictures by clicking on the image, then holding down the Alt key.  You can then drag the image by clicking in the middle and dragging, or resize it by dragging one of the corners.





	At the bottom of the screen are the Reading Comprehension Questions.  There are three to five questions per lesson.  You can click the left or right arrows on the bottom right of the screen by the question number to scroll through the questions.  After you answer a question, you can push F2 to see a suggested answer.  Remember that, except for the multiple choice, most answers are subjective, meaning that there is usually not only one answer which is correct.


	


	Pull-Down Menu





	At the top of the Reading screen there is a pull-down menu with the two main headings File and Exit.  Exit exits.  Under File are listed six menu options: Print, Font, Ruler, Save, Export, Insert Image.





	When you choose Print, the program will ask you which items you want to print.  You can print the reading selection, the reading comprehension questions, your answers to the questions, or any combination of the above.  The reading selection is printed on one page and the questions (and/or your answers) are printed on a second page.





	Font and Ruler, as explained above, let you change the format of the reading selection.





	Save saves the current changes that you have made to the selection.  However, you should remember that no changes can be saved to your CD.  If you want to make permanent changes to the selections, you need to use the Copy Files to Hard Drive function in the Setup section of the program.  (You generally do not have to actually use the Save command.  The program will automatically prompt you to save if you have made any changes.)





	The Export function copies the current reading selection to a file on your hard drive.  You can export in Rich Text Format (RTF), TXM format (a format internal to the Middle School Language Arts program), or plain text.  If you export in Rich Text Format, you will be able to load the file into Microsoft Word or almost any other word processor.  Note that the plain text export will not export formatting (such as italics) or pictures.





	Insert Image lets you insert an image into the reading selection.  You can import from several popular formats including bitmap (BMP), Windows Metafile (WMF) or TIFF.  Once you have imported an image, you can click on the image and then use the Alt key and mouse to position or resize the image to your liking.





III.2. Spelling


	


	When you choose spelling, you will first see the spelling/vocabulary word list.  You can study this on-screen or print out the word list.





        When the test starts, the first word is pronounced.  You should type in the spelling of the word in the box provided.  Push -Enter- when done.   To hear the word pronounced again, press the ear button.  To go to the next word, press the Next button, or exit by pressing the Exit button.  Your percentage of words correct is shown in a graph at the left.





	After you are done, the program will display the words which you missed.  You can print this list out for further study.





III.3. Vocabulary





	Four different formats are available in vocabulary: multiple choice, matching, sentence, and scramble. To choose the test format, click the radio button of the format you want.  Before going to the test, the program will display the word list, which you can either study on-screen or print out.


	


III.3.A. The Multiple Choice Test 





        The Multiple Choice test is very straightforward, and should not be difficult to understand.  The target word is presented in a box at the top of the screen.  Underneath the target word are four definitions.  Choose the number corresponding to the definition of the target word.  The program will tell you if you make the right choice.  If you miss a word, the program will tell you this, and will also highlight the correct definition. 





        At the top, the program notes which word list you are using.  At the bottom right, the program notes the word you are currently on.  To see a word used in a sentence, click on the word.  To hear the pronunciation of a word, shift-click on the word. 





        To go to the next word, click on Next.  The program will allow you to skip words without guessing their definitions, but it is generally not a good idea to do so.  To exit from the test, click the Exit button. 








III.3.B. The Matching Test





        On the left side of the screen are five target words, with the letters A through E next to them.  On the right side of the screen are the definitions, with boxes next to them.  Match the definitions with the correct word.  To do this, use the drag-and-drop method.                 





        If you want to change a letter, then you can "undo" the dropped letter by double-clicking on it.  Of course, each letter can only be placed with one word at a time. 





        When you are through entering your choices, click on the OK button at the bottom right of the screen.  At that point the program will display a happy face for each word you got right and a "not-happy" face for each word wrong.  If you want to skip a set of words, you can click the Next button. 





        To hear the pronunciation of any of the words on the left, click on the word.  





        After the program displays which words are right and wrong, the "Next" button changes to "PUSH ME!".  Click that button to go to the next set of words.  If you want to end the test, use the Exit button. 





III.3.C. Letter Scramble





        Along the top of the screen of the letter scramble test is the definition of a word.  Underneath the definition, the letters of the word are scrambled in boxes.  To unscramble the word, drag and drop and letters in the lower boxes in the proper order.   If you prefer, you can simply type the next letter instead of using drag and drop.





        To undo any letter, double click on the letter.  To check that the letters you have placed are correct, push the check button.  If you are stumped, press the Solve button. 





        Note: The letter scramble is not included in the graphs that measure your progress about number of words right and wrong. 





III.3.D. Sentences





        The sentence test helps you gauge your knowledge of words in real-world use.  On this test, you should fill in the blank by clicking (or pressing) the number of the BEST word to complete the sentence.  There may be times when more than one word could possibly fit in the sentence, but one word will be BEST based upon the context of the sentence. 





        To hear any of the words pronounced, click on the word. 





        The sentence test is very similar in appearance and operation to the multiple choice test. 





III.4. Writing Helps





	Proficiency in the written and spoken word is the reason for mastering the language arts.  The writing section of Middle School Language Arts helps you focus on one aspect of writing in each grade.  Grade 4 covers paragraph writing.  Grade 5 focuses on short essay writing.  Grade 6 covers non-fiction writing.  Grade 7 covers fiction writing.  Grade 8 focuses on letter writing.  The four writing lessons in each grade are not meant to be comprehensive treatments of the subjects, but they will definitely get you started on writing and give you good advice on how to communicate in several different modes.





	The Writing Helps section of each grade contains three sections: Learn, Outline, and Write.





	You will notice that you can choose numbers 1 through 4 in the Outline and Write sections.  This is because you can save up to four outlines and four writing selections in the program.





III.4.A. Learn





	The Learn section of the Writing Helps contains the actual writing lessons.  The lesson begins with an outline of what is included in the lesson.  You can click on any of the items in the outline to go right to that point in the lesson.  Within each lesson there are areas to click to answer questions or to write a paragraph or an outline.





III.4.B. Outline





	The Outline section helps you to create an outline for writing one or more paragraphs.  For more information on how to outline in general, use the pull-down menu item How to Outline under the Help pull-down menu heading.





	Under the pull-down menu item File, there are six menu options: Load, Save, Print, Copy to Clipboard, Export, and Exit.





	Load will load a saved outline that you have already made for a lesson.





	Save will save the current outline that you are working on.





	Print will print out the current outline.





	Copy to Clipboard will make a copy of the outline which can then be pasted into any other Windows application using the Paste command.





	Export will copy the current outline to a file on your hard drive that you can then load into a word processor or other program.  The exported file is in straight text format.





	Exit leaves the outlining module.  You will be prompted to save your outline if you not already done so.





III.4.C. Write


	


	The Write section of the program brings up a full-featured word processor including a spell checker.  You can write, print, add pictures, etc., using the word processor.  You can also import or export files to or from your hard drive.





	If you have created an outline for your paragraph, you can import your outline into your document using the Load Outline function under the File menu header (File/Load Outline).





III.5. Practice





	The practice section of the program contains three game functions: Crossword Puzzle, Space Bugs, and High Card Wins.





III.5.A. Crossword Puzzle





	The Crossword Puzzle is a straightforward, traditional crossword puzzle.  Most of the clues in the crossword puzzle are synonyms and antonyms.  A synonym is a word that means the same thing as another word.  An antonym is a word that means the opposite of another word.





	You can choose which word to work on either by clicking on a square in the crossword puzzle, or by clicking on a clue in the clues section.  You can see the correct letter for the current square by pushing the F1 key.  Once you successfully complete a word, that word will turn red in the puzzle section and the clue will be disabled.





	The pull-down menu items under Puzzle are: Erase Puzzle, Print, Save and Exit, and Exit.  Erasing the puzzle erases all the work that you have done on the puzzle.  Print prints out a copy of the puzzle.  You can print either a blank puzzle or the puzzle in progress with the work you  have done on it.  Please note that crossword puzzles can only be printed properly on laser printers. 





	The pull-down menu items under Help are: How to Play and View Word List.  How to Play gives you some information about using the crossword puzzle.  View Word List will show you a list of the words in the current puzzle.  The words in the word list are in the same order as the clues.





III.5.B. Space Bugs





	Space Bugs is a simple arcade type shooting game.  The bugs try to drop bombs on you while you shoot them with your proximity missiles or your photon torpedoes.  Shoot missiles by pushing Enter, or shoot photon torpedoes by pushing Space.  You can move your ship using either the arrow keys on the keyboard or your mouse.  Right mouse button moves right, left mouse button moves left.


	


	You can blow up the bugs that move across the screen, but you cannot blow up the bugs at the top.





	Proximity missiles blow up things near to them.  You only have to shoot near a bug to blow it up.  You can also blow up bombs with proximity missiles, so it is good to have a supply of them on-hand.





	When you run out of missiles or torpedoes, you will receive another shipment from your base.  However, you must have the password in order to be resupplied.  The password is provided by clicking on the correct word for the definition given.  If you miss it, you are not resupplied, but you can always try again.





	There are three levels of difficulty, with the third being extremely difficult to survive.  You can achieve a higher score by conserving your fuel and not moving except when necessary.  Each level ends when you run of fuel on that level.





III.5.C. High Card Wins





	High Card Wins is similar to the old hangman game.  A word is displayed in the panels at the top, with the active panels being red and the inactive panels black.  You need to guess a letter at a time until you guess the word.  You can guess either by typing a letter or clicking on a letter in the list.  After you use a letter it is disabled so that you cannot reuse it.





	At the bottom of the screen are six cards dealt to you, along with one card dealt to the computer.  You can see the card dealt to the computer, but your cards are face down.  Each time you choose a letter not in the word, you lose a card.  When you get all the letters in a word, your cards are turned over.  If you have a card which is higher than the computer's card then you win.  If the computer's card is higher than all of your remaining cards, the computer wins.  If you run out of cards before you get the word, you automatically lose.  The first one to five wins.





	Strategy tip:  Pick vowels and common letters such as R, S, T, N, and L first.





IV. Utility Functions





	At the bottom of the main screen are a series of push-buttons: User, Graphs, About, Setup and Exit.





IV.A. Users





        The Users function is self-explanatory.  To run Middle School Language Arts you need at least one user.  If you have only one user, that is the current logged user.  If you have more than one user, you can set a current user by highlighting a user in the list box and clicking on the Current User button.  You can have up to fifty users on one computer.  However, these users are shared among all the grade levels.





        You can also delete or reset a user by highlighting the user and clicking on the appropriate button.  Deleting a user removes that user name from the user list.  Resetting a user leaves the user name in the list, but it deletes all user data used for generating graphs. 





        You cannot delete or reset the current user.  So, if you only really want one user, but want to delete or reset the current user, you will have to add another user temporarily, then make the new user the current user, and delete or reset the other user.  (It is less complicated than it sounds.) 





IV.B. Graphs





        Pushing the Graphs button on the main menu screen will bring up a graphing package which helps you to see your progress in learning words. 





        The graphing package will show you either the total you  have gotten right or wrong in all the lists, or right and wrong in each list.





        Below the Available Graphs pick list is a "Graph Types" pick list, in which you can choose from several different types of graphs, including bar graphs and pie graphs.  Which graph types are available depends on what figures are being graphed. 





        The last pick list on the left is the "Graph Background" box, which changes the background and foreground colors of the graph. 





        You can change users while in the graphing function by pushing the User button in the bottom right hand corner.  You can also erase the figures the program uses to generate graphs by using the Reset function from the User window. 





        Graphs generated by the program can be printed to a printer, or copied to the clipboard.  If you are printing the graph, it can be printed in either color or black and white.  If you are copying to the clipboard, the graph is copied in color, in Windows metafile format.  Since metafiles can be stretched or shrunk to any size, they are very convenient if you want to include a graph in another application. 





IV.C. About





        The About box brings up the credits for all the hard working people who brought you this program.  It also plays one a series of classical music pieces, varying by grade.  Click anywhere in the form to remove it from the screen.





IV.D. Setup





        The Setup functions of the program offer ways for you to customize the Middle School Language Arts program to your tastes.  Through the Setup functions, you can set many program options, including the use of sound and fonts.  Additionally, you can add to or modify the word lists which come with the program.  You can also print out any or all of the words. 


                                                    


        When you load the Setup window, the last word list you used will be automatically loaded as well.  If you have not used any word file, then the file GRxWRD1.DBF (first word list) will be loaded (where "x" is the grade level) .  The name of the currently loaded word list is displayed at the upper left corner of the screen.  If, for some reason, the word file cannot be found, then the program says "No File Loaded."





        The name of the file displayed in the top left of the window is a numerical file name.  For instance, if you load the tenth list in grade 5, then the file name would be GR5WRD10.DBF.  Word lists are in FoxPro/dBASE (DBF) format and can be loaded into many different database, word processing, or spreadsheet programs.





        The Setup window has a pulldown menu system along the top, and a set of four pushbuttons along the bottom.  The four buttons are Next, Previous, Blank, and Restore.  These buttons operate on the words in the currently loaded file.  The Next and Previous buttons will show you the next or previous word in the file.  The Blank button will erase all fields for the current word.  The Restore button will restore all fields to their previous contents, in case you make a change that you decide you do not want.  Once you go to the next or previous word, however, changes cannot be undone.   Please note that changes to words cannot be saved to your CD.  In order to save changes to word files, you need to use the Copy Lesson Files to Hard Drive function under the File pull-down header.





        To edit fields, simply click the mouse on the field you want to change, or use the Tab key to change fields.  You can easily see the current edit field because it has highlighted colors.





IV.D.1. The File Menu 





        The File menu has five choices: Open, Print Word File, Print Words from All Lessons, Copy Lesson Files to Hard Drive, and Quit Maintenance.  Quit closes the file maintenance window and takes you back to the main menu. 





IV.D.1.A. Open





        When you choose Open, a list appears from which you can specify which word list you want to use.  The file you specify is looked for in the current directory or the current path.  (You can change paths by using the Paths... function under the Setup pull-down menu header.)





IV.D.1.B. Print Word File


 


        When you choose the Print Word File function, the program will first ask you if you want to print the current word file. If you say that you do want to print, then another box will pop up to show you the progress of the printing.  The printed output is in the currently selected font, at 10 point.  Since the printing function uses the currently selected font, the printed output may take one or two pages. 


  


IV.D.1.C. Print Words from All Lessons





	This function will print an alphabetical listing of all words in the current grade level. (It can take a lot of paper.)  At the end of the definition of each word is also printed the number of the word list in which the word is located.





IV.D.1.D. Copy Lesson File to Hard Drive





        Middle School Language Arts can run almost entirely from the CD, but if you want to edit the word lists, you need to copy the word files to your hard drive.  This is because the CD is read-only and no changes can be written to the CD. 





	The lesson files are copied to your user directory on your hard drive, unless you specify a different directory.  Along with the word lists, the reading files and puzzle files are also copied.  You are also given an opportunity to copy the pronunciation WAV files to your hard drive.  If you copy pronunciation to your hard drive, pronunciations will be played much more quickly in the program.





	You can also use Windows' File Manager to copy all the files from the CD's to your hard drive.  If you do so, you should make a separate directory for each grade level.  Once you copy all the files for a grade level from the CD to your hard drive, you will not need your CD in the drive in order to use the program.





	Once the files are copied, the program will ask you if you want to set your hard drive as the new source of word lists and pronunciation files.  You would normally say that you do want this.





IV.D.1.E. Quit Maintenance





	Quit Maintenance saves whatever word or program setting changes you have made and returns to the main menu.





IV.D.2. The Setup Menu





        The Setup menu has seven functions: Path to Data, Show Derived Words, Play Sounds, Sound Volume, Start Sound Recorder, Fonts, and Users.  





IV.D.2.A.  Paths to Data





        Setting data paths tells the Middle School Language Arts program where to look for your data files.  Middle School Language Arts uses three different paths: word files, sound files, and user files.  Word files are the files of words, reading selections, writing lessons, and crossword puzzles.  Sound files are the pronunciation WAV files for the words.  User files are where information about users, used to generate graphs, is kept. 





        Normally, your WAV and word files would be on your CD.  This would only change if you copy the word files to your hard drive in order to edit them.  When you run the program, these directories are set by default to your CD. 





        When you first run the Middle School Language Arts program, the program will automatically create a user directory on your hard drive.  This is C:\MSLAx (where "x" is the current grade level) by default, but you can change it. 





IV.D.2.B.  Editor





	The Editor menu option lets you set a word processor that you want to use for writing paragraphs.  By default the program uses its internal, full-featured word processor.  However, if you are accustomed to using a different word processor, you can set that word processor to load when you write paragraphs.





	If you do change the editor, however, the Middle School Language Arts program will not be able to automatically load word processing documents or outlines into your editor.  Of course, you can still copy Outlines to the clipboard and paste them into another editor, or export documents from the internal editor and load them into another editor.





IV.D.2.C.  Play Sounds





	If you enable Play Sounds, then different sounds will be generated by the program as you use it.  This has no effect on the pronunciation WAV files. 





        NOTE: Due to the way in which Microsoft Windows handles sound, it is possible that other programs may not be able to generate sound while Middle School Language Arts is running with Play Sounds enabled.  Also, if, for any reason, Middle School Language Arts terminates abnormally with an error, you may need to restart Microsoft Windows before any program can use sound. 





IV.D.2.D.  Volume





        Sound Volume controls the volume of the pronunciation WAV files.  Your sound card may also contain software to set sound volume (most do).  And, if you have amplified speakers, you can always just turn them up or down. 





IV.D.2.E.  Fonts


                   


        The fonts dialog box lets you pick the primary font for use with Middle School Language Arts.  This font is used in all the tests, as well as for printing word files. 





        The font selection box is the common dialog box for selecting Windows fonts. 








IV.D.2.F.  Users


 


        The Users function is self-explanatory.  To run Middle School Language Arts you need at least one user.  If you have only one user, that is the current logged user.  If you have more than one user, you can set a current user by highlighting a user in the list box and clicking on the Current User button.  You can have up to fifty users on one computer.  However, these users are shared among all the grade levels.





        You can also delete or reset a user by highlighting the user and clicking on the appropriate button.  Deleting a user removes that user name from the user list.  Resetting a user leaves the user name in the list, but it deletes all user data used for generating graphs. 





        You cannot delete or reset the current user.  So, if you only really want one user, but want to delete or reset the current user, you will have to add another user temporarily, then make the new user the current user, and delete or reset the other user.  (It is less complicated than it sounds.) 





IV.D.2.G.  Version Info


	


	Version Info lists the current version of Windows you are running and the current version of Middle School Language Arts.  This information may be helpful to technical support people if you have any problems running the program.





IV.D.3. Web Links


	


	Web links lists some web sites of companies which have contributed in some way to Middle School Language Arts.











Appendix A 


Program Errors 





        Most program errors that may occur are handled by the program in such a way that you will not even know that an error happened.  This is the case for such errors as "File not found" errors, or printer errors. 





        Other errors may occur when the screen display does not look right.  Many video cards for Windows come with a large number of video drivers, some of which may not work properly with Middle School Language Arts.  If a particular driver does not seem to work, you should try switching to another driver.  The standard VGA and Super VGA drivers which come with Windows 3/3.1/3.11 or 95 should always work properly. 





        It is possible that an error may occur which the program cannot handle.  In that case, Middle School Language Arts will give an error message and end.  Usually, the error will go away just by restarting the program.  If the error does not go away, and you need to contact technical support about an error, please have ready 1) the text of the error message, 2) the circumstance(s) under which it occurs, and 3) whether the error is reproducible (does it happen every time).  This will help us to correct the error. 





	


Pro One Technical Support Numbers:





North America: (505) 532-6000


Europe: (44) 1661-860270


